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Preface 
FINE FIRE, the Fully INtegrated Environment for Fire Fighting Installations performs all 
necessary hydraulic calculations and can handle tree, loop and grid sprinkler systems. It 
calculates automatically pipe diameters and friction losses, finds the most unfavourable 
and favourable areas of the network and selects the fire pump with the Hydraulic solution 
method. 

This Quick Start Guide provides a fast and friendly introduction on FINE FIRE main 
features and functionalities. In conjunction with this guide, you can find helpful step-by-
step videos in www.4msa.com. All the features and functions of the program are 
presented and explained in detail within the complete User’s Guide, along with informative 
examples. 

FINE FIRE combines both designing and calculations in a uniform, integrated environment, 
consisting of two main components, CAD and Calculations:  

• Concerning the CAD component, it is based on an autonomous CAD embedding 
4MCAD engine adopting the common cad functionality and open dwg drawing file 
format. The CAD component helps the user to design and then calculate and produce 
completely automatically the entire calculations issue for every Fire fighting project, as 
well as all the drawings in their final form. 

• Concerning the Calculations component (called also as ADAPT/FCALC), it has been 
designed according to the latest technological standards and stands out for its unique 
user - friendliness, its methodological thoroughness of calculations and its in-depth 
presentation of the results. The FIRE Calculation module acquires data directly from the 
drawings (automatically), thus resulting in significant time saving and maximum reliability 
of the project results. It can also be used independently, by typing data within the 
calculation module spreadsheets. 

Despite its numerous capabilities, FINE FIRE has been designed in order to be easy to 
learn. Indeed, the simplicity in the operation philosophy is realized very soon and all that the 
user has to do is to familiarize himself with the package.  

This Guide is divided into 3 short parts: 

- Part 1 describes the installation procedure and the main menu structure. 

- Part 2 deals with the CAD component of FINE FIRE, showing its philosophy and main 
features. 

- Part 3 describes the calculation environment of FINE FIRE. 
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1. Installation - Launching 
 

1.1 Installing FineFIRE 
1. Insert the CD in your computer CD-ROM drive (e.g. D:, E:) or, if you received your 

software via Internet, run the installation application you downloaded. 

2. When the Welcome window appears (as shown below), click Next. 

 
3. When the License Agreement appears, read it carefully. If you agree with the terms, 

check the respective button and then click Next (you must agree with the terms to 
proceed with the installation). 

4. In the next screen enter your username and organization information and check if you 
want to create a desktop icon. Then click Next to see if the information is correct (see 
the following window) and finally click Install for the installation procedure to begin. 

5. Upon completion of the installation procedure, the following last window appears on 
screen and all needed is to click Finish. In case that the Run FINE 14NG checkbox is 
selected, the program will start running. 
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6. After the installation, you can find the program within the programs list. 
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2. CAD Component 
 

2.1 Overview 
FineFIRE is the powerful Workstation for Fire Fighting installation design that 
automatically performs the necessary calculations directly from the drawings, producing 
all the Project results (Calculation issue, technical descriptions, full-scale drawings, Bills of 
materials etc.). FineFIRE automates the designing process providing the user with the 
appropriate installation designing solutions. 

This first Part of the user's guide (Part I) describes the operation of the CAD component of 
FineFIRE. As mentioned in the preface, the CAD component is based on 4MCAD 
technology.  

Regarding technical aspects, it should be mentioned that the package follows a 
completely object oriented philosophy (OOP). This practically means that the package 
considers the building and the FIRE installations as logical entities which consist of 
individual objects clearly related to each other and with accurately defined characteristics. 
These intelligently structured “information” of the building and its fire fighting installations 
combined with the advanced technology (C++) that was utilized for its development, 
provide the package with an experienced behavior, resulting in an Intelligent Workstation, 
that is an invaluable helping hand to every Designer.  

FineFIRE CAD Component includes two main modules, which co-operate closely and give 
the designer the impression that he virtually works on the building: It is about a) the 
AutoBUILD (or AutoBLD) that is used to load-identify the building and b) the AutoNET that 
is used to design and identify the network installations. Those two subsystems are 
supported by a third one, with the name PLUS, which includes many useful designing 
facilities. 
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2.2 Main menu  
As soon as the program is loaded, the main menu screen appears for the first time: 

 
Among the commands of the designing environment, we notice the following main options 
of the package: 

1. Project files management options (New Project, Open Project and Project Information) 
which are located into the options group FILE. 

2. Option Group with the name AutoBLD, which includes all the commands required for 
the Architectural designing. 

3. Option group with the name AutoNET, which includes all the commands required for 
the designing and calculation of the application. 

4. Auxiliary option group with the name PLUS, which contains a series of designing 
facilities for the user. 

 

Starting with FINE, you define a new project 
through the corresponding option in the FILE 
menu mentioned above. In case that "New 
project" is selected, a window appears on the 
screen where the name of the Project should be 
typed. 
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In order to "load" an existing project, which has been created with the program and 
you want to further edit it or just 
view it, you select "Select Project", 
and a list with the existing projects 
in the hard drive will be displayed 
on the screen. At first, the list 
displays all the projects that exist 
in the FINE directory and with the 
use of the mouse or the keyboard 
and acting correspondingly, you 
can transfer to any other directory, 
viewing at the same time the 
existing projects. It is noted that 
the projects are included into 
directories with the extension BLD. 
If an existing project is selected, it is loaded and displayed on the screen. 

Either if a new project is created or a saved one is loaded, you can start working with the 
use of the subsystem commands described above. A detailed description of these 
commands is available in the following chapters. Before this detailed description, a short 
reference of the basic designing principles featured in the designing environment of the 
package is recommended, in chapter 2.3 that follows next. If you are familiar with the use 
of 4MCAD or AutoCAD, you may page through or even skip this chapter, while if you are 
not, you should read it carefully. 

2.3 Drawing Principles & Basic Commands 
A great advantage of the package is that the structure and the features of the drawing 
environment follow the standards of the CAD industry adopted by AutoCAD, 4MCAD etc. 
In particular, the available working space is as follows: 

 
As shown in the above figure, the screen is divided into the following "areas": 
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• Command line: The command line is the area where commands are entered and the 
command messages appear. 

• Graphics area: The largest area of the screen, where drawings are created and 
edited. 

• Cursor: The cursor is used for drawing, selecting objects and running commands from 
the menus or the dialog boxes. Depending on the current command or action, the 
cursor may appear as a graphics cursor (crosshairs), a selection box, a graphics cursor 
with a selection box etc. 

• Pull-down menus: Each time you select one of these commands (AutoBLD, AutoNET 
etc.) a pull-down menu is shown. 

• Status Line: It is the line on the bottom of the screen where the current level, the 
drawing status and the current cursor coordinates are displayed. From the status line 
you can enable or disable tools such as SNAP, GRID, ORTHO etc., which are 
explained in the following chapter. 

• Toolbars: You can arrange which toolbars you want to be shown in the screen in each 
project. To enable or disable a toolbar, in the upper part of the screen (where the 
existing toolbars are shown) right click with the mouse and select the desired toolbar 
from the list (as it is shown below). 

 

2.3.1 Drawing aids 
This section describes the most important drawing aids. These are the commands: 

SNAP: The graphics cursor position coordinates appear in the middle of the upper part of 
the graphics area. If "Snap" is selected, the graphics cursor movement may not be 
continuous but follow a specific increment (minimum movement distance). To change the 
increment, right click with the mouse on “SNAP” and choose “Settings”. To activate or 
deactivate it, double click on the “SNAP” icon. 

GRID: The screen grid is a pattern of vertical and horizontal dots, which are placed at the 
axes intersection points of an imaginary grid. The grid can be activated or deactivated by 
clicking the corresponding icon or by pressing F7.  

ORTHO: The "Ortho" feature restricts the cursor to horizontal or vertical movement. The 
status bar shows whether the "Ortho" command is activated by displaying "ORTHO" in 
black characters. The command is activated or deactivated by clicking the corresponding 
icon or by pressing F8. 
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ESNAP: The "Esnap" command forces the cursor to select a snap point of an object, 
which is within the Pick box outline. The esnap points are characteristic geometric points 
of an object (i.e. endpoint of a line). If you have specified a snap point and move the 
cursor close to it, the program will identify it with a frame. The "Esnap" command can be 
activated either by holding down the "SHIFT" key and right clicking the mouse or through 
the additional toolbar. 

2.3.2 Drawing Coordinates 
When you need to determine a point, you can either use the mouse (by seeing the 
coordinates in the status bar or using the snap utilities), or enter the coordinates directly in 
the command line. Moreover, you can use either Cartesian or polar coordinates and 
absolute or relative values, in each method (relative coordinates are usually more 
convenient). 

Relative coordinates: Enter the @ symbol (which indicates relative coordinates) and 
then the x, y, z coordinates (Cartesian system) or the r<θ<φ coordinates (polar system) in 
the command line. The system used (Cartesian or polar) is defined by the “,” or “<” symbol 
respectively. If you do not insert a value for z or φ, it will be automatically taken as zero. 
For example, if you are prompted to locate the second (right) endpoint of a 2m horizontal 
line, you enter: 

@2,0 if you use the Cartesian coordinates (which means that the distance of the second 
point from the first is 2 m on the x axis and 0 m on the y axis), or 

@2<0 if you use the polar coordinates [which means that the second point is at a distance 
of 2m (r=2) and an angle of 0 degrees (θ=0) from the first]. 

Absolute coordinates: They are specified in the same way as the relative coordinates 
but without using the @ symbol. The absolute coordinates are specified in relation to the 
0,0 point of the drawing. 

The measurement system can be activated, deactivated or changed with the F6 key. 

2.3.3 Drawing Basic Entities 
In the “Draw” menu you will find the basic drawing entities: 

Line: "Line" option is used for drawing segments. When you select "Line" from the menu 
or type "Line" in the command line, you will be prompted to specify a start point (by left 
clicking or by entering the point coordinates – relative or absolute – in the command line) 
and an endpoint (determined in the same way). 

Arc: The "Arc" command is used for drawing arcs. An arc can be drawn in different ways: 
the default method is to specify three points of the arc ("3-Points"). Alternatively, you can 
specify the start point and endpoint of the arc as well as the center of the circle where it 
belongs (St, C, End). You will not find it difficult to understand and become familiar with 
the various methods of drawing an arc. 

Polyline: This command allows you to draw polylines, which are connected sequences of 
line or arc segments created as single objects. The command is executed by either using 
the menu or typing "pline" in the command line. You will be prompted to specify a start 
point and an endpoint (by right clicking the mouse or by entering the point coordinates – 
relative or absolute – in the command line). Then, the command options will appear (Arc, 
Close, Length etc).  Select A to switch to Arc mode, L to return to Line mode and  C to 
close the polyline. 
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2.3.4 Useful Commands 
This section includes brief descriptions of the basic program commands, which will be 
very useful. These are the commands "Zoom", "Pan", "Select", "Move", "Copy" and 
"Erase" (you will find them in “View” and “Modify” menus). In particular: 

Zoom: "Zoom" increases or decreases the apparent size of the image displayed, allowing 
you to have a "closer" or "further" view of the drawing. There are different zooming 
methods, the most functional of which is the real-time zooming ("lens / ±" button). You can 
use the mouse to zoom in real time – that is to zoom in and out by moving the cursor. 
There are a number of zoom options as shown by typing "Zoom" in the command line: 
All/Center/Dynamic/Extents/Left/Previous/Vmax/window/<Scale(X/XP)>. 

Pan: "Pan" ("hand" icon) moves the position of the visible part of the drawing, so that you 
can view a new (previously not visible) part. The visible part of the screen moves towards 
the desired area and to the desired extent. 

Select: This command selects one or more objects (or the whole drawing), in order to 
execute a specific task (erase, copy etc.). Select is also used by other CAD commands 
(for example, if you use the "Erase" command, "Select" will be automatically activated in 
order to select the area that will be erased).  

Move: This command allows moving of objects from one location to another. When the 
"Move" command is activated, the "Select" command is also activated so that the object(s) 
you want to move (in the way described in the previous paragraph) can be selected. 

After you have selected the desired object(s), you are prompted to specify the base point 
(using the snap options), which is a fixed point of the drawing. When you are prompted to 
specify the position where the base point will be moved, use either the mouse or the snap 
options. After you have completed this procedure, the selected object(s) will move to the 
new position. Please note that the base and the new location points can be also specified 
with the use of coordinates (absolute or relative, see related paragraph). 

Copy: The "Copy" option allows the copying of objects from one location to another. The 
"Copy" procedure is similar to the "Move" procedure and the only difference is that the 
copied object remains at its original location in the drawing. 

Erase: Choose this option to delete objects. The procedure is simple: Select the objects 
you wish to erase (as described above), type "E" in the command line and press <Enter>. 
Alternatively, you may first type "E" in the command line, then select the object(s) by left 
clicking and finally right click to erase the object(s). 

DDInsert (Insert > Insert Block): This command allows you to insert another drawing 
(DWG file) or block in the drawing. When this command is selected, a window appears in 
which you select block or file and then select the corresponding block or file from disk. 
Then you are prompted to specify the insertion point, the scale factor etc., so that the 
selected drawing is properly inserted. 

Wblock: The "Wblock" command allows us to save part of a drawing or the entire drawing 
in a file, as a block. When this command is selected, you are prompted to enter the file 
name and then you select the drawing or the part of the drawing you wish to save. The 
use of this command is similar to the "Screen Drawing" command in the AutoBLD menu, 
which will be described in a following section. In order to insert a block in a drawing, you 
use the "ddinsert" command described above. 

Explode: The "Explode" command converts a block in a number of simple lines so that 
you can edit it in that form. If it is selected, the program will prompt you to select the block 
("Select object") you wish to explode. 
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2.3.5 Grips 
Grips are some characteristic points of an object, 
which appear after it is selected (by moving the 
cursor on the object and left clicking). The object 
is displayed with grips (small squares in blue 
color), which mark control locations and are 
powerful editing tools (by selecting one grip you 
can for example, move or change the length of 
the line). When you click a grip, the following 
prompt appears in the command line: 
**STRETCH** <stretch to point> /Base point 
/copy/ undo/ exit. If you press <Enter> (or right 
click), the first characters of the corresponding word are entered, e.g. “sc and enter” for 
the "Scale" command). 

When a command is executed, grips disappear and the objects are deselected. If the 
command is an editing command (correction or copy), which can be preselected, the 
objects take part in the execution of the command automatically. In this case, the 
command overrides the "Select objects" prompt and proceeds. To deselect grips and 
objects you should press <Esc> twice: once to deselect the objects and twice to 
deactivate the grips. 

In each object the positions of the grips are different. Namely, for a point the grip is the 
point itself, for a segment the grips are the midpoint and the two endpoints, for an arc the 
midpoint and the two endpoints, for a circle the center and the quadrants, for a polyline 
the endpoints of the line and arc segments and the midpoints points of the arc segments, 
for a spline the spline points, for a block the insertion point, for text the insertion point etc. 

2.3.6 Print 
This section may be read after you have created a drawing and you want to print it. Any 
drawing can be printed using a printer or plotter or to a file. Printing is performed using 
"PLOT" command, selected either from the "FILE" menu or typing it in the command line, 
provided there is a drawing already loaded.  

Viewing a drawing before printing gives you a preview of what your drawing will look like 
when it is printed. This helps you see if there are any changes you want to make before 
actually printing the drawing. 

If you are using print style tables, the preview shows how your drawing will print with the 
assigned print styles. For example, the preview may display different colours or line 
weights than those used in the drawing because of assigned print styles. 

To preview a drawing before printing 
1. If necessary, click the desired Layout tab or the Model tab.  

2. Do one of the following:  

� Choose File > Plot Preview.  

� On the Standard toolbar, click the Plot Preview tool ( ).  
� Type ppreview and then press Enter.  

3. After checking the preview image, do one of the following:  

� To print the drawing, click Plot to display the Print dialog box.  

� To return to the drawing, click Close. 
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The Plot dialog box is organized in several areas as it is shown in the picture below. For 
help defining print settings before you print, see Customizing print options. 

In the plot window, you can select the printer, the paper size and the number of copies 
and several plot options such as the style (pen assignments), the orientation etc. 

Moreover, you can select the plot scale and the plot area. Before you proceed to printing, 
you select “Apply to layout” and then “Preview” so as to make any modifications you might 
want. 

To print a drawing 
1. If necessary, click the desired Layout tab or the Model tab.  

2. Do one of the following:  

� Choose File > Plot.  

� On the Standard toolbar, click the Print tool ( ). If you click the Print tool, the Print 
dialog box does not display. Your drawing will be sent directly to the selected printer.  

� Type print and then press Enter.  

3. From the Plot dialog box, make any adjustments to the settings.  

4. Click OK.  

 

2.3.7 Plus Drawing Tools 
Those tools belong to the large group of options under the general menu PLUS. These 
are a series of additional drawing tools, which have been embodied in the package in 
order to help the user during drawing, and are described within the Full User’s Guide. 
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2.4 AutoBUILD: Architectural Drawing  
The AutoBUILD option group, as we will see in detail below, includes all the facilities 
required to insert a building and create an architectural drawing. As it is shown in the 
corresponding AutoBLD menu, the various options are divided into several sub-groups. 

 
In general, the first sub-group includes commands for the definition of the project 
parameters, the second sub-group includes drawing commands, the third sub-group 
includes commands for linking to the calculations and the fourth includes management 
options for the AutoBLD libraries and commands for the building supervision. In the 
following sections, the options reported above are described one by one, beginning with 
the "Building Definition" option. 
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2.4.1 Building Definition 
If you select the "Building definition" 
option, the floor management menu 
appears. 

On this screen the levels of the project 
building are defined, which means that 
you determine the level and the 
corresponding architectural drawing (a 
dwg file ground plan) of each building 
floor (only in case you use a drawing 
that was created by another architectural 
designing program). More specifically: 

� In the "Level" field, define the Level 
(floor) number. 

� In the "Elevation" field, define the 
height of the floor level. You can define manually a benchmark for level measurement 
(e.g. the pavement). You may also define negative levels (e.g. -3 m for the basement). 

� In the "Name" field, define the name of the level (e.g. Ground floor). 

� In the "File" field, define the path and the name of the relevant DWG drawing file, only 
if you refer to an already existing drawing (which means that you do not intend to draw 
the ground plan from the start). If there is no DWG architectural drawing available, 
leave the filename blank.  

The insertion and the management of ground plans are performed with use of the xref 
command. At the bottom of the dialog box there are four functions available which are 
actually used to manage the floor files. More specifically: 

� Press the “New” button to save a new floor or the changes in the data of a floor (e.g. 
level, dwg drawing).  

� Use the "Current" option to select the ground plan/file you want to work on each time. 

� Select the "Delete" option to delete the floor you want (after you have selected it). The 
"Delete" command removes the ground plan of 
the relevant floor in the project.  

� The “Accept” command closes the dialog box (it 
does not save the floor data. This can be 
managed with the “New” command). FineFIRE 
enables also the use of a “scanned” ground plan, 
which is a ground plan in a bitmap file created by 
a scanner. In this particular situation the steps to 
follow are described in detail within the User’s 
Guide. 

The “Layers Management” option gives you the 
choice to enable or disable in a quick and practical 
way (during working) several layers. If you want, you 
can disable any element group by simply clicking 
inside the indicator-box of the corresponding group. 
When the box is checked, the corresponding group is 
enabled.  
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2.4.2 Drawing Walls 
AutoBLD menu contains all the commands required for 
drawing and editing walls, such as parallel moving of 
walls, trimming, extending, joining and breaking walls as 
well as placing openings of any kind on them (windows, 
sliding doors, openings, arches). During the initial 
drawing, as well as during any modification at any stage, 
the drawing is automatically updated (e.g. placing an 
opening on a wall does not break the wall in two parts, 
the opening moves easily from side to side whether you 
are working on the ground-plan or on a 3D view and the 
wall is restored without leaving undesirable lines after 
deleting an opening etc.).   

The Wall option, located at the second subgroup of the 
AutoBLD group of commands, includes the Outer, Inner, 
Outer wall from polyline, Inner wall from polyline and Outline options as well as the option 
subgroup Modify, Delete, Extend, Break, Join, Trim and Move. The first subgroup 
concerns the wall drawing, while the second their further processing after being drawn. By 
selecting Outer Wall, first of all its attribute dialog appears with a series of parameters 
(type, dimensions, colours etc.), which are described in detail within the User’s Guide.  

In order to start drawing a wall, you click OK and then follow the instructions shown below: 
Outer wall (straight / arc): After activating the command (by pressing <Enter> in the 
menu), you are required to successively provide: 

i) the starting point of the wall (the application message in the command prompt is: ‘’Wall 
start \ Relative to wall \ Toggle shape <Linear>’’) 

ii) the ending point of the wall (the application message in the command prompt is ‘’Wall 
end \ Relative to wall \ Toggle shape <Linear>’’) 

iii) the direction towards which the wall shall grow, by providing any point on one of the 
two half-planes defined by the wall line (the application message in the command prompt 
is "Enter Side Point"). 

 
After the above actions, you can see that the wall has been drawn and that you can 
continue to draw another wall starting from the ending point you defined earlier, unless 
you right click, which means that you want to stop (or press “ENTER”). You can change 
the wall drawing from linear into circular, typing T in the following program prompts and 
pressing <Enter>. During drawing, one can come to the conclusion that the ability of 
drawing consecutive walls is very convenient since it prevents you from making many 
movements.  
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As mentioned further below, in the “Element Parameters” section, the thickness of the 
wall, its height and its level in relation to the floor level (when the level is 0, the wall starts 
from the floor), are stored within the “Element Parameters” for the wall. By providing 
proper values for the wall height and level, any possible case of walls of unequal height 
can be dealt with. The techniques and tools for creating walls are described in detail within 
the User’s Guide. 

Further to the drawing functions, the program also provides powerful editing tools, such as 
erase, modify (through the wall dialog box), multiple change etc.. Within the User’s Guide 
there are complete instructions regarding the above commands plus the applicable 
commands Copy, Stretch, Extend, Trim, Break, Unify, Mirror, Rotate, Scale, Base point. 
Two other commands that are widely used while drawing the walls are a) the Undo 
command, which enables you to reverse the previous command executed and b) the 
Properties command, which enables you to view (and change) the attributes of the 
selected wall.  

2.4.3 Drawing Openings 
Once the command "Opening" is activated, a second option menu is displayed, including 
a variety of opening types (window, sliding door, door etc) to draw, plus also a set of 
editing functions such as "Erase", "Modify" or "Move", applied to existing openings.  

Window: The option "Window" asks you to select the wall on which the opening will be 
placed and then define the beginning and the end of the opening (all these actions are 
carried out using the mouse and pressing <Enter> each time). The window will 
automatically obtain the data that are predefined in the “Element parameters”, namely the 
corresponding values for the height, the rise, the coefficient k etc.). Of course, you can 
draw the window from the ground plan as well as in the three-dimensional (3D) view. 
During drawing a window, it is very helpful the fact that, after the wall where the window 
will be automatically placed is selected, the distance from the wall edge is displayed in the 
coordinate’s position on the top of the screen, while the crosshair is transferred parallel to 
the wall for supervision reasons. The measurement starting point (distance 0) as well as 
the side (internal or external) is defined by which one of the two edges is closer and which 
side was "grabbed" during the wall selection. Similar functionality exists for other types of 
openings, such as Sliding Doors, Doors, Openings etc. All the details are included within 
the User’s Guide. 

2.4.4 Other Entities 
AutoBLD provides tools for designing columns and other elements, as well as drawing 
libraries including drawings and symbols to place within the drawing (i.e. general symbols, 
furniture, plants etc.). Details are shown within the User Guide of FineFIRE. 

Finally, the Building model of a FineFIRE project can be viewed through the commands: 

� Plan View (2D): The two-dimensional plan view of the respective building level is 
shown. 

� 3D View: A three-dimensional supervision of the ground plan of the current floor (with 
given viewing angles) is shown.  

� Axonometric: Provides three-dimensional supervision of the whole building (for all 
floors), with the given viewing angles as they have been selected in "Viewing 
Features". 
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2.5 AutoNET: Network Drawing Principles   
The option group AutoNET includes all those tools the designer needs in order to draw 
(and then calculate) the Fire fighting installations. Below are described the general 
AutoNET commands and you will find the specific commands for Fire fighting in the next 
chapter. 

Drawing Definition: The layers for each installation are organized properly and the 
information is shown on the respective dialog. The command "Color" is used to assign the 
desired color to each network while the command "Linetype" is used to select the desired 
line type.  

Copy network of Level: ΑutoNET enables copying of typical (installation) plan views and 
pasting them on other levels through this command, which functions similarly to the “copy 
level” option of the AutoBLD menu. When you select this command, the program prompts 
you to select the network you want to copy (you can select it in a window), and after you 
do it and press ENTER, it asks you to give the number of the level in which you want to 
copy it. 

The commands and the basic principles and rules for drawing the network are described 
below: 

Network Drawing: The installation network drawing is carried out with a single line, by 
drawing lines and connecting them to each other, exactly as the network is connected in 
fact. You should keep in mind some general principles regarding drawing and connecting 
between straight or curved, horizontal or vertical network branches.  

Horizontal & Vertical Piping: In any case, the piping drawing is carried out exactly as the 
line drawing (in AutoCAD or 4MCAD). You are able to draw horizontal or vertical pipes. 
The pipe installation elevation is the current elevation. Modification of the pipe installation 
elevation is possible through the menu PLUS -> Set elevation (or if you type the command 
"elev"). If you type "elev" (in the command line), you are prompted to determine the new 
current elevation. Press <Enter> if it is 0 or type the value you want. At this point it should 
be emphasized that, if a horizontal piping which is found on a specific level is drawn and 
connected to another piping or a contact point (receptor), the program automatically 
"elevates" or "lowers" the pipe so that connecting to the other pipe or receptor, 
respectively, is possible. In this way, the program facilitates the drawing of piping in three 
dimensions while you are actually working in a two-dimension environment. In any case of 
a network design, all facilities provided by AutoCAD can be utilized through relative co-
ordinates. 

Vertical pipe Drawing: Drawing vertical pipes which cross floors (one or more) is 
possible through the option "Main Vertical pipes (Building)". When the respective option is 
selected from the menu, the program asks for the pipe position ("Enter xy Location") and 
then for the height of the starting point ("Enter Height for First Point") as well as the height 
of the ending point ("Enter Height for Second Point"). For example, if you want to draw a 
vertical pipe from 0 to 3, by inserting the location point (XY) and then the numbers 0 and 3 
successively, the symbol for direction change appears on the ground plan and in 3D View. 
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Vertical sections within the same floor: 
If you want to elevate or lower a pipe 
within the same floor, you can use the 
relative coordinates. For example, if you 
have drawn a horizontal pipe (in elevation 
of 0 m) and you want to elevate it to 2 m, 
when in the command line asks for “Enter 
next point”, you will type @0,0,2 and 
continue drawing the pipe (see the 
adjacent photo). In the same way, if you 
want to lower the pipe by 2 m, you will 
type @0, 0,-2.  
Drawing Curved Pipes: You can draw curved pipes by inserting the points from which 
the curved pipe is to pass (give at least 3 points). The respective command prompts for 
the following: 

� First point: Insert the starting point of the pipe. 

� Next point: Insert next point, the one after that and so on (successively), defining the 
pipe routing in this way and to stop press <ENTER> or right click of the mouse. 

You can easily modify curved pipes using “grips". As soon as the pipe is selected, grips 
appear which you can select and move, altering this way the pipe routing. In the Bill of 
Materials and the Calculations sheet, the program will measure the pipe length precisely. 

Connecting network sections: Connections between network sections (horizontal, 
vertical or both) as well as between network parts and appliances can be easily executed 
by using the "Snap" commands. For example, suppose that the two horizontal parts of the 
ground plan below, which are placed in different heights, have to be connected. If you 
start by "grabbing" the "upper" pipe end and then end up at the "lower" pipe end, the result 
in the three-dimension representation will be as on the right. 
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Special Commands for Pipe Construction: This is actually a set of commands aiming 
to facilitate the drawing of the installation piping. More specifically, there are two basic 
commands: 

� Multiple supply pipes: Multiple pipes can be drawn, when the in between distance is 
known, by simply defining the routing. 

� Pipe parallel to Wall: A pipe parallel to the wall (or walls) that you mark is drawn, with 
a given distance from the wall, in printing mm (which depends on the printing scale as 
well). The program asks for the first point and afterwards the wall or the walls 
(successively) parallel to which (in a certain fixed distance) the pipe is to be drawn.  

� Pipe parallel to Points: A pipe is drawn parallel to the points you defined (supported 
by automatic snap), with a given distance from the crooked line defined by these 
points. The program asks for the first point and then for the other points (successively) 
parallel to which is desired to have the pipe drawn. When all points are inserted (and 
you right click the mouse), the distance will be requested. 

� Pipe parallel to Wall (or Points) and Receptor Connection: This is a particularly 
useful command similar to the two commands above "Pipe parallel to wall" and "Pipe 
parallel to points", which, however, enables selecting the receptors to be automatically 
connected to the routing which will be drawn parallel to the walls or the points. 
Therefore, it is possible to connect a whole set of appliances to the nearest vertical or 
horizontal pipe, with only 2-3 moves.  

For better understanding of the command function, assume that in a given room with its 
appliances is desired to install a pipe parallel to the wall and connect the appliances to it. 
The steps are the following: 

� Select the "Pipe parallel to points and receptor connection" command and the 
following options will appear:  

� Select receptors: Select the receptors to be connected to the pipe applied in a parallel 
arrangement against the wall by defining certain points on the wall. 

� Enter the first point & enter the next point: Provide the points parallel to which you 
want to install the pipe. The points are shown on the drawing with an X. 

� Distance from a point <1.00>: Provide the distance in printing mm where the pipe is 
going to be drawn starting from the inserted points.  

The program draws the pipe and connects it to the receptors. 
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Modify an existing network: You can edit an existing network by using any CAD 
command (i.e. copy, move or erase etc. of a network section) or utility (i.e. grips) during 
the design process. The only rules to apply here are the following: Pipes supplying the 
appliances (receptors) should be connected to the touch points of these receptors. 
Obviously only one pipe can be connected to a touch point. The connection with the touch 
points which appear as red "stars" in the ground plan can be executed with the "esnap" 
function. Piping can be branched to one another and extend in any way as long as they do 
not form loops, something which does not apply to reality anyway. If however a mistake 
occurs, the program (during the recognition procedure) will perform all checks and 
indicate the mistake and its location. A necessary step before the "Network recognition” is 
defining the point “1” where the network starts, which is the supply point “1”. In reality, this 
point corresponds to the Fire Pump. In FineFIRE application, the menu includes specific 
options, so that you can be easily guided when drawing any installation.  

Placing the receptors: Placing a receptor can be done simply through the following 
steps:  

� Select a receptor (from AutoNET->Receptors window) and press "OK" (or alternatively 
double click). It can be observed that the receptor moves on the ground plan with the 
graphic cursor.  

� If you move the mouse properly, the receptor can be carried in such a way that its 
base point (which coincides with the cross of the graphic cursor) can be placed in the 
desired point. Right click or <ENTER> to confirm your selection. 

� If you move the mouse again, the receptor will rotate around the base point. Thus, if 
you confirm the angle in which you want to place the receptor (again by right clicking), 
the receptor "freezes" in its final position.  

You can also insert and place either the whole receptor or only its touch points in the 
ground plan by checking one of the two options in “Receptors” window. This is significant 
when an existing ground plan includes drawn receptors and there is no need to redraw 
them, but just move the touch points so that the information for the respective supplies will 
be available.  

Regarding the installation height of a receptor, it should be pointed out that receptors are 
always installed in the current height. The current height can be changed with the "Set 
elevation" command (from the PLUS menu). 

Fittings: The "Fittings" command selects the accessories to be also inserted in the 
drawings, which applies exactly the same as the receptors. 
Fittings have "touch points" upon which the piping will be 
connected so that the network can be recognized. A 
symbol may also have more than one touch points (e.g. a 
collector), in which case the fitting will be numbered as a 
junction point in the "Network Recognition". The program 
provides the capability of cutting off the line automatically 
when a symbol is inserted on the line, exactly where the 
accessory interjects. This capability is defined by the 
indication of the accessories box "Break Pipe". If this 
option is activated, then the program will automatically 
"Break" the pipe when the accessory is placed. Moreover, 
the "Move Symbol" indication is in the same box, which 
defines whether the accessory will be moved in relation to the position it was initially 
placed (so that it will be placed parallel and on top of the pipe) or the pipe will be moved 
(so that the accessory can be attached).  
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Symbols: "Symbols" include various general symbols, layout of machines and other 
drawings that can be used in the corresponding installation. 

Network Recognition and Numbering: Since the network has been drawn according to 
the current rules and the supply point has been 
determined, the "Network Recognition" option converts the 
network in the required standard pattern and updates 
appropriately the calculation sheet. During updating, 
junction points and receptors are numbered on the ground 
plan. Note that if a receptor is not numbered, it means that 
it is not connected to the network. Besides, if a network 
section has a different color, it is not correctly connected to 
the network. Connect it or select "Break at selected point" 
at the connection point with the previous pipe.  

Calculations: The "Calculations" option leads you to the 
corresponding calculating environment, which means that 
a new window of the current application is “opening”, while 
FINE FIRE remains "open". In order to transfer the data 
from the drawings, you should select "Update from Drawing" in the "Files" menu of the 
corresponding calculating application (in order to carry out the corresponding calculations, 
answer "Yes" to the question "Calculate" that appears). It has to be noticed that the 
numbering of the sections, the lengths of the network sections, the receptors with their 
supplies and the fittings (from the piping routing) are transferred in the calculation sheet. 
Of course, if you want to, you can intervene in the calculations in order to make any 
modifications.  

Legend: The "Legend" option creates a legend with all the symbols that have been used 
in this specific project. By selecting it, the program asks for the location where the Legend 
is going to be inserted. Use the mouse to define the location and the legend will appear 
automatically on your screen, 
exactly under the location point.  

Vertical Diagram: This option is 
used for the automatic creation of 
the vertical diagram of the 
installation and in its appearance on 
the screen, within few seconds. In 
case there is already a vertical 
diagram, the program asks if you 
want to update it. It is obvious that, 
in order to create a vertical diagram, 
you should draw and identify a 
network and enter the calculation 
sheet, so that the program knows all 
the data needed for the vertical 
diagram creation (pipe dimensions, junction points numbering, etc.). By the “creation” 
command the window of the vertical diagram’s manager appears on screen. This window 
is composed of two parts, the part with the network tree and the part with the vertical 
diagram. Through appropriate commands, you can intervene in several ways on the 
output of the diagram:  

� Enable or disable various sections of the network 

� Change the order of the columns of sub-networks in the vertical diagram 

� Change the sub-networks direction connection on the vertical columns (right or left) 
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� Read the information of each node 

� Describe the sub-networks 

The changes done in the vertical diagram with 
the help of the above icons are displayed in 
real time, in the second part of the window. On 
the upper side of this window there are also 
icons for processing the diagram (real time 
zoom and pan, zoom extends etc.). In addition, 
in the upper-left side there are some other 
icons having to do with the appearance of the 
screen, such as the hiding of the left part of the 
window, the appearance of the level names 
and heights on the left to be edited, the 
appearance of the numbers of the receptors, 
the layers and others. 

Finally there are some options for the initialization of the vertical diagram, its 
reconstruction and the definition of the drawing parameters. In 
particular, the drawing parameters depend on the application and 
include the following options: 

Layers: Through a supervisory window table, you can define the 
drawing scale, the colors corresponding to the various layers and the height of the texts 
(in mm drawn on paper) placed on the vertical diagram. 

Drawing distances: The drawing distances that will be considered on the creation of the 
diagram, are also defined on mm drawn on paper. 

Blocks: There can be defined on each application different network starting points and 
type of tables. You can choose from a set of dwg drawings. 

Miscellaneous: A set of attributes concerning the form of the vertical diagram is defined, 
considered as collector, whether the z height information will be considered in the diagram 
creation and whether the sub-networks pipes on the vertical diagram will be placed over 
or under the receptors. Finally, it should be mentioned that during the editing procedure 
concerning the vertical diagram manager, if there are mistakes the program displays the 
proper messages and warnings. 

Libraries Management: This option leads to a submenu including the options 
"Numerics", "Drawings" and “General symbols”. The first option leads to the libraries with 
all the numerical data of the materials. The "Drawings" option leads to a dialog box where 
the following data can be seen, regarding each application. The “General symbols” option 
leads to a dialog box where several symbols can be seen and edited. 
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2.6 AutoNET: FineFIRE Installation 
The previous chapter described the drawing 
principles, while the present one describes those 
commands in relation to the special features of 
FINE FIRE.  

Regardless of the fact if there is an AutoBLD 
building model, an external reference, a digital 
image or even no architectural drawings, a Fire 
Fighting installation can be drawn and then 
calculated. 

Although there are no limitations regarding the 
order of actions followed in drawing an installation, 
the following order is suggested: 

� Create one or more fire fighting spaces 

� Place the receptors in them (Sprinklers, Fire 
Hose Cabinets etc.) manually or automatically 

� Draw the horizontal pipes 

� Connect the receptors to the pipes 

� Draw the vertical pipes 

� Connect the horizontal to the vertical pipes 

� Define the Supply point(s) 

� Run “Network Recognition” 

� If there are no mistake messages, proceed to 
the calculations 

Create fire fighting space: With this command 
you can draw a fire fighting space where the 
sprinklers will be placed. Type a name for the 
space, define a minimum density and select the 
type of the hazard among the categories ‘’Light”, 
‘’Ordinary’’ and ‘’High’ (the hazard description is only for reference on reports). The space 
can be defined either by points or by polyline.  

Modify fire fighting space: You can change an existing fire fighting space by selecting 
its name, pressing <Enter> and editing the space. 

Placement of the Receptors to the drawing: We select “Receptors” either from the 
AutoNET menu or from the “Fire Fighting” toolbar. When all receptors' window appears, 
select the type of the receptor, which will be placed at the specific point. 
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The receptors are placed as it was described in the previous chapter. In case they already 
exist on the architectural plan view, then we just click at the “Touch points only” field. 

 
Sprinklers Grid: If you want to draw a sprinkler grid automatically, in this window fill in the 
following fields: 

• Receptor: From the ‘’Receptor’’ button select from the library the type of the sprinkler 
and automatically the ‘’Maximum area of coverage’’ will be filled in.  

• The next step is to select the area of the grid by: 

� giving points on the drawing 

� selecting a polyline 

� drawing automatically a rectangular area or 

� choosing a fire fighting space that has already been drawn 

Note: If the selected area is not rectangular, the program frames it with a rectangle 
and calculates its surface and the number of the sprinklers which will be placed inside 
the selected area.   

Automatically, the ‘’Frame dimensions’’ and the ‘’Area’’ are updated and the program: 

� Proposes a minimum number of sprinklers.  

� Suggests the number of the rows and the columns. For rectangular areas, the 
number of the sprinklers is the result of the multiplication between the rows and 
the columns. For non-rectangular areas, the program calculates the rows and the 
columns of the framed area and shows the number of the sprinklers which will be 
placed inside the non-rectangular area.  

• Grid angle: In order to select the angle of the sprinklers array, click on one of the 
edges of the selected area. 
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• Next, you give the number of the ‘’rows’’ and the ‘’columns’’ you want (you can follow 
the suggestion of the program or select your own design). When the ‘’number’’ fields 
are filled in, the program automatically calculates the vertical and horizontal distances 
from the outline and the intermediate distances. You can edit the distances in any of 
these fields and the program will make again the calculations. 

• Reset distances: This button is used if you made changes in the distances and you 
want to reset them in the initial results of the program.  

 

Create area of coverage per sprinkler: This command divides the fire fighting space in 
sprinkler coverage areas. The program checks if each sprinkler can cover its area and if it 
can, the coverage outlines are in green color. If it cannot, the outlines are in red color and 
if the area intersects with another, the outlines are in yellow color. Each time you select 
again the command and choose the same fire fighting space, the program automatically 
deletes the previous coverage areas and recreates them. 

Delete area of coverage per sprinkler: This command deletes all the coverage areas of 
a fire fighting space, by selecting the space and pressing <ENTER>. 

Set group to receptors: This command is used for creating a group of sprinklers. Select 
one or more sprinklers of the drawing and type the number of the group on the command 
line.  

Add group to receptors: The same sprinkler can belong to multiple groups. With this 
command, you can select one or more sprinklers that are already part of a group and type 
the number of the additional group which you want them to be part of. 
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Remove group from receptors: This command removes one or more sprinklers from 
their groups by selecting them and pressing <ENTER>. 

Fittings: You can select “Fittings” either from the AutoNET menu or from the “Fire 
Fighting” toolbar. When all Fittings' windows appear, you select the type of the fitting, 
which will be placed at the specific point. 

 
Horizontal networks design: After you place the appliances, as described earlier, you 
proceed with the design of the vertical and horizontal pipes of the level. After the design of 
the vertical and horizontal pipes, you perform the connection of the piping to the 
receptors. For the reduction of both the time needed for the specific work and of the errors 
we suggest the use of the “Connect receptors to existing pipe” command. When you 
select it, the program asks you to define the appliance(s) which will be connected to a 
specific part of the pipe, then the pipe and when you press <ENTER> they are 
automatically connected. 

Design of the networks’ Vertical pipes: You draw the vertical pipe as it was described 
in the previous chapter, giving the pipe position, the starting and the ending points. We 
must point out that the heights of the vertical pipes are dependent upon the level heights 
of the building that you defined in “Building definition”. All pipes will be connected to the 
vertical pipes through the “Perpendicular” snap point.  

Set of Supply Point(s): From the edge of the vertical pipes connect the horizontal pipes, 
and place the supply point to the end of it. It is important to use the Endpoint snap to 
connect the supply point to the horizontal pipe. 

 
Network recognition: Select “Network recognition”, in order for AutoNET to recognize 
the network and prepare the files for the connection with the calculations. During the 
recognition, messages warn you for potential drawing errors. For example there might be 
closed routes of the horizontal pipes, points at which different types of pipes end, lack or 
false placement of the supply point, elements unconnected etc. Besides, no “white” parts 
should appear on the network, which means that they haven’t been “recognized”. As soon 
as you correct them, run again the “Network recognition” and if there are no mistake 
messages, proceed to the calculations. 
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Notes: 
- If you have drawn a fire fighting space without defining a “Minimum density”, you will get 
a warning message. Nevertheless, you can proceed to the calculations without a problem. 

- The warning messages “Sprinklers with Density=0” and “Sprinklers with maximum 
coverage =0” do not apply to the calculation methods “NFPA Ordinary Hazard pipe 
schedule” and “Hydraulic Calculations”. 

- You can ignore the warning messages “Sprinklers with Density=0” and “Sprinklers with 
maximum coverage =0” if they are shown for the fire hose. 

Calculations: When the control is completed we’re ready to go to the computing 
environment. By selecting “Calculations” the Fire Fighting calculations are displayed in a 
new window. When select “Files” and “Update from drawing”, the data is transferred at the 
calculation sheet.  

Find node: You can easily find any node you want by typing its number on the command 
line. 

Update Drawing: After the calculation part of the program is completed, save the project 
file, return to the drawing program (FINE FIRE) and select “Update Drawing”. The 
following window will open and you will select the information you want to be shown on 
the drawing. Particularly: 

- In the left part of the window, you select the information you want to be shown 
regarding the pipes. You can select to see information for all the pipes (choose 
“Select All”), some of them (choose “Select from Drawing” and select the pipes from 
the drawing) or none (choose “Deselect All”). Furthermore, below this list, you can 
choose which information you want to be shown, such as the length, the flow rate, the 
diameter etc. If you do not want, for example, the “Velocity” to be shown, select it and 
uncheck the “Selection” button. 

- In the right part of the window, you select the information you want to be shown 
regarding the receptors. You can select to see information for all the receptors 
(choose “Select All”), some of them (choose “Select from Drawing” and select the 
receptors from the drawing) or none (choose “Deselect All”). Furthermore, below this 
list, you can choose which information you want to be shown, such as the receptor 
name, the water flow etc. If you do not want, for example, the “Group” to be shown, 
select it and uncheck the “Selection” button. 

Finally, to place the information on the drawing, select either “Manually placement” or 
“Auto Placement” (the program automatically chooses to place the information for each 
pipe and receptor in the best position without covering each other). 

You can easily move the position of the data on the drawing selecting “Move drawing 
update Data” (from the AutoNET menu) or change their height and style from the “Space 
text style” command (from the AutoBLD -> Element parameters) and run “Update drawing” 
again.  
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Draw Most Favourable, Most Unfavourable Group and Area: With this command the 
program automatically highlights the most favourable (with green color) and unfavourable 
(with red color) areas. Furthermore, the program finds the 4 sprinklers under consideration 
of the favourable area (in green linetype) and of the unfavourable area (in red linetype). 

Other drawing actions – Completion of the draws: Next, we place a control faucet in 
front of each apartment or property, or wherever else it is required. From the “Fittings” 
dialogue box we select the faucet having checked the “Pipe Cutting” box. We select the 
pipe and place the faucet. Apart from that, we must place the counters (flow-meters). The 
draws regarding the counters, general assemblies manufacturing details and so on can be 
selected from  “Details” command (AutoNET -> Symbols) or from the “Fire Fighting” 
toolbar and the corresponding icon. 

 
Finally, we can attach a legend as it was described in the previous chapter. 

Convert single line to 3D: This command converts the single line pipes of the drawing to 
3D. The diameter of the 3D pipes is directly related to the calculation results and 
therefore, before you run this command, you have to update the drawing.   

Axonometric Drawing: The axonometric drawing produced automatically with the use of 
FINE provided that the network was designed at the specific program. From AutoNET we 
select “Axonometric Drawing” > “Create”. Then the following window appears: 
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Vertical Diagram: The vertical 
diagram is produced automatically 
with the use of FINE FIRE provided 
that the network was designed at the specific program. From AutoNET we select “Vertical 
diagram” > “Create”. Then the following window appears: 

 
You can apply all the desired changes as it was described in the previous chapter or close 
the window, which will result to the display of the design in a DWG form, which you can 
modify using the provisions of CAD programs.  
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3. Calculations 
3.1 Introduction 
This chapter provides a description of the Calculations Component of FineFIRE. This 
module can be used either independently, by filling the numeric data, or in co-operation 
with the CAD component of FineFIRE, in which case the calculation environment acquires 
the data directly from the drawings. 

 
At the top of the application window appear the general options of each application menu, 
constituted of the group options "Files", "Project Data", "View", “Windows”, 
"Libraries" and "Help".  

The core of the calculations is the calculation sheet, a spreadsheet-like environment with 
specific capabilities and facilities tailor-made for each application. More specifically, 
regarding FineFIRE, which refer to an installation network, the calculation sheet is shown 
in a spread sheet using lines corresponding to the network branches, and columns 
containing primary data (e.g. length) and results of calculations (e.g. water velocity) for 
each branch. An example of such a sheet for the Fire Fighting Application is shown below: 
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In order to make the network understandable by the program, a specific standardization 
should be followed, which is more or less the same in all applications. The standardization 
is easily understood with the following simple example. 

Suppose we have the network shown in the adjacent 
figure. This network comprises several branches (i.e. 
parts of the network), junction points and terminals 
(end points). Thus in this network, we have assigned 
arbitrary numbers to both the junction points (1,2,3) 
and the hydraulic terminals (4,5,6). Each junction 
point may be assigned a number or a letter (lower or 
upper case, e.g. A, d etc) or a combination of letters 
and numbers (e.g. A2, AB, eZ, 2C etc.). The main 
logical restriction is that in the starting point is always assigned the number 1. Also, 
assignment of the same number twice in the same network is not permitted for obvious 
reasons, with the exception of junction point 1 for which assignment may be repeated as 
desired (for networks with more than one starting points). After numbering the junction 
points and terminals according to the above rule and in order to represent the network in 
the spread sheet, it is enough to give a name to the various sections of the network 
entered in the first column of the spread sheet. Having in mind that the order of network 
sections is not important, we fill in the first column with the two junction points of each 
section (putting a dot in between) so that the sequence of junction points matches the 
direction of water flow in the pipe. In the above example the sections 1.2, 2.3, 2.6, 3.4 and 
3.5 should be filled in (order is arbitrary). In some other columns of the row we fill in a 
series of data (e.g. length of section, accessories included in the section etc.) which 
depend on the type of installation while the output resulting from calculations and updating 
the remaining columns depend also on the particular installation.  

Taking as a reference point the above spread sheet and ignoring initially the filled in 
values, we can see the columns heading zone (every column has its title and units), the 
zone for filling in values with a number of rows (separated with dotted lines for better 
supervision and clarity) and a status bar (at the bottom of the window) where helpful 
information appears depending on the position we are in the spread sheet. Since the 
spread sheet contains usually a lot of information and is the core of the calculations in 
each application, it is particularly useful to have it maximized on screen by clicking on the 
upper arrow (located at top right of the window), so that the whole computer screen area 
is utilized.  
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The next section will familiarize you with the “Calculation Sheet”, as the basic functions 
described therein apply to every application. 

The Calculation Sheet provides the user with all the editing functions, which are described 
below: 

First of all, as stated earlier, in the frames where the Calculation Sheets appear the 
user can change the "Font" option for both the calculations zone (so that values appear 
with the desired size and style) and the headings zone (so that headings are shown to the 
user satisfaction). 

As far as the headings zone is concerned, the user has also the possibility to increase or 
decrease the column width using the mouse: As long as the mouse pointer rests on the 
vertical line separating two adjacent columns, it takes the form of a double arrow and then 
by pressing (and keeping pressed) the left mouse button and dragging, the column width 
is increased or decreased depending on the direction of mouse movement.  

The above alternative supervision possibilities available to the user depend on several 
factors such as the resolution of the graphics card and screen size, and for this reason 
any possible interventions are left to the user discretion. For that matter, there is also the 
possibility of “Load Prototype” from the user. Note however, that best supervision results 
are achieved with higher resolutions and large screens. 

Access to the positions of the zone for filling in values is carried out by means of the 
mouse and the arrow keys of the keyboard. Moving the mouse pointer in the zone for 
filling in values we can see that in some columns the pointer takes the form of a vertical 
line (|) while in other columns it takes the form of a prohibitive traffic sign. We cannot 
modify the values contained in these last columns (because they result from calculations). 

If we move the mouse pointer (having the form of a cross) to a cell or small square and 
click the left mouse button, we’ll see that the cell contour (outline) becomes dark and we 
can fill in a value or modify the cell content. In the same way we can move to any other 
cell, or using the <Enter> key we move to the next cell below and using the <Tab> key we 
move to the next cell at the right and so on. Besides, in case the window width is not large 
enough to accommodate all columns, we can review the entire calculation sheet by 
manipulating it up-down or left-right using the vertically or horizontally sliding keys 
(potentiometer like). In addition, when access to a column for filling values is denied, the 
mouse pointer takes the form of a prohibitive traffic sign. This way, the user is informed 
that the quantity under examination is a derivative one i.e. resulted automatically from 
calculations.  

The user should keep in mind the following useful commands when entering values in 
the Calculation Sheets of any application: 

Deleting cell content: Pressing the <Del> key on a cell, the value it contains is deleted, 
and the cell is blank. 

Deleting a row: Pressing the keys <Ctrl>&<Del> in combination, the row we are in is 
deleted. 

Inserting a row: Pressing the keys <Ctrl>&<Ins> in combination, a new (blank) row is 
inserted immediately below the cell we are in. 

Moving to the beginning of a row: Pressing the <Ηοme> key we move automatically in 
the first column of the row we are in. 

Moving to the end of a row: Pressing the <End> key we move automatically in the last 
column of the row we are in. 

Moving to the upper part of the sheet (first column-first row): Pressing the keys 
<Ctrl>&<PgUp> in combination, we automatically move in the first column-first row of the 
calculation sheet. 
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Moving to the lower part of the sheet (first column-last row): Pressing the keys 
<Ctrl>&<PgDn> in combination, we automatically move in the last row of the calculation 
sheet. 

Finally, you can move from an upper to a lower cell using the <Εnter> key and from a 
left cell to a right cell using the <Tab> key. 
In addition, the calculation sheet provides the user with a set of Spreadsheet Functions, 
which are available in most windows applications, such as the Cut-Copy-Paste type of 
commands of a subset of lines (or even the whole calculation sheet), the row and columns 
width definition, the font type (as well as font attributes, justification etc) of a selected 
area, and so on. By selecting a certain area of the sheet (or all of it by “select all”) and 
then pressing the right button of the mouse, a small menu appears on screen, with the 
relative commands. Another useful command is the Undo/Redo command concerning the 
calculations. All those editing commands are also applied to other windows. Apart from 
the copy-paste command, in case we want to repeat a row (typical branch), it is sufficient 
to fill in the content of the first column, i.e. the section name that will make a copy of the 
row except for the section name, which remains blank. When the calculation sheet is 
activated, you will see in the main menu options an additional one namely “Calculation 
Sheet” with a secondary option “Printing Parameters”. Selecting “Printing Parameters” the 
adjacent dialog box appears from where the user may affect the appearance of the printed 
Calculation Sheet. Specifically, the user may define a bold outline (frame), a normal 
outline, or no outline, horizontal and/or vertical lines, as well as a raster for the titles 
(headings) of the spreadsheet with the desired shading of tints (using the sliding key).  

3.2 Main Menu 
If you want the Fire Fighting System application to be executed, point with the mouse and 
double click on the relevant icon, and the main menu window will appear: 

 
As you can see, the basic menu options are divided into the groups "Files", "Project 
Data", "View", “Windows”, "Libraries" and "Help", which are described below along 
with their secondary options. 
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3.3 Files 
The "Files" option includes the usual file management options according to the windows 
standards: 

New project: Type a name for the new project you want to be saved in a file. 

Project selection: A window appears where you can select the desired (existing) project 
file and load it. 

Caution! If neither a new nor an existing project is selected, the program automatically 
considers that the UNNAMED project is active. If you add new data to the UNNAMED 
project and you want to save it with a different name, select “Save as” and type the new 
project name. 

Update from Drawing: In the case of co-operation with the FINE package, the project 
calculation sheets are updated with the drawing data. 

Caution! If the option "Update from Drawing" is selected, without previously opening a 
project and inserting rooms in the ground-plans using the FINE package, any existing data 
in the calculation sheets will be replaced with blanks. 

Save Project: The project you are currently working on is saved to the hard disc (with the 
previously given name). 

Save Project as: The project you are currently working on is saved in a different file with 
a new name. 

Load Prototype: The saved prototype appears on the screen. 

Save as Prototype: The form, which has been created by the user and is displayed on 
the screen when this option is selected, is saved as a Prototype. 

Printing Prototypes: The printing prototype management window is activated. 

Printing: The project issue is printed according to the selected options in "Printing 
Contents" and "Printing Parameters" as well as according to the print preview output. 

Printing Contents: You can select the Fire Fighting System project items you want to be 
printed. 

Printing Parameters: The desired printing parameters can be selected in this window. 

Print Preview: The complete project issue appears on the screen, exactly as it will be 
printed, page to page. 

Export to RTF: An rtf file, containing the project items, is created (within the project 
directory, with the name PYRO.RTF). 

Link to WORD: A .doc file, containing the project items, is created (within the project 
directory, with the name PYRO.DOC). At the same time, the MS-Word application is 
activated (if it is installed in your PC). 

Link to 4M editor: An rtf file, containing the project items, is created (within the project 
directory, with the name PYRO.RTF). At the same time, the 4Μ text editor is activated for 
further editing.  

Link to Excel: An xls file, containing the project items, is created (within the project 
directory, with the name PYRO.xls).  

Export to PDF: A pdf file, containing the project items, is created (within the project 
directory, with the name PYRO.pdf).  

Exit: Exit from the application. 
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3.4 Project Data  
The basic project data are divided into Project Info (project headings) and Network data. 
Project info refer to titles and headings related to the project identity, while the "Network 
Options" window refers to the general network data that you should specify and are 
related to: 

Water temperature (°C): The water temperature value is filled in and the relevant 
viscosity is taken automatically into consideration for the calculations. 

Type of building: Select the type of the building from the list that opens if you press the 
key in the field and the relevant coincidence curve is taken into account. 

Primary pipe type:  With the key <F11> or by pressing the key in this field, you can 
select from the window that appears, the primary pipe type which shall be used in the 
project (e.g. steel pipe). 

Primary pipe C Value: This option is visible if one of the methods Fully calculated 
systems NFPA 13, Fully calculated systems EN 12845, Fully calculated systems AS 2118, 
Fully calculated systems BS 9251, Fully calculated systems FM Global, or Fully calculated 
systems CEA 4001 has been selected. The C value of the primary pipe is entered 
automatically depending on the pipe type selected, but you can easily modify it.  

Primary pipe Roughness factor: This option is visible if one of the methods NFPA 
Ordinary Hazard Pipe Schedule or Hydraulic Calculations has been selected. In this field 
the roughness factor of the selected primary pipe appears automatically but if you want, 
you can modify it (in μm). 

 
Secondary pipe type: With the key <F11> or by pressing the key in this field, you can 
select from the window that appears, the secondary pipe type which shall be used in the 
project (in case two types of pipes are used). 

Secondary pipe C Value: This option is visible if one of the methods Fully calculated 
systems NFPA 13, Fully calculated systems EN 12845, Fully calculated systems AS 2118, 
Fully calculated systems BS 9251, Fully calculated systems FM Global, or Fully calculated 
systems CEA 4001 has been selected. The C value of the secondary pipe is entered 
automatically depending on the pipe type selected, but you can easily modify it. 
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Secondary pipe Roughness factor: This option is visible if one of the methods NFPA 
Ordinary Hazard Pipe Schedule or Hydraulic Calculations has been selected. In this field 
the roughness factor of the selected secondary pipe appears automatically but if you 
want, you can modify it (in μm). 

Maximum designed water velocity (m/s): Enter the maximum designed water velocity. 
In this way, the pipe with the smallest possible cross-section, for which the velocity does 
not exceed this value, shall be selected. You can modify the maximum velocity either from 
here as a whole (and it shall be applicable in every part of the network) or within the 
calculations sheet for every network section in the “Max velocity” column.  

Maximum velocity for the stabilized flow condition at the demand point (m/s): Enter 
the maximum velocity for the stabilized flow condition at the demand point. This value will 
be used in the network checking of the sections’ velocities. 

Hazard classification: Select the hazard classification among “Light”, “Ordinary” and 
“High”. This is for reference on reports only. 

Calculation method: You can choose among several calculation methods: NFPA 
Ordinary Hazard Pipe Schedule, Hydraulic Calculations, Fully calculated systems NFPA 
13, Fully calculated systems EN 12845, Fully calculated systems AS 2118, Fully 
calculated systems BS 9251, Fully calculated systems FM Global, or Fully calculated 
systems CEA 4001.   

Import data from the Vertical Diagram: This option enables you to draw the vertical 
chart firstly with the aid of an expert system and thereafter to transfer the data in the 
calculation sheet (it is used in case you do not want to generate automatically the vertical 
diagram from FINE FIRE). If you check this box, the option “Draw vertical diagram” 
appears in the program menu and you can use it in order to draw the vertical diagram. 

Calculate automatically: In big projects where the calculations are time consuming, you 
can uncheck this field, make any changes you want in the network and then press the 
“Calculations” button to run the calculations. 

3.5 Draw Vertical Diagram 
This option includes the two secondary options “Vertical Diagram Creation” and “Update 
from vertical Diagram”, which are explained in the following paragraphs. 

3.5.1 Vertical Diagram Creation 
This option has the following secondary options: 

1. Diagram type 
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• Appliances > Transfer as simple appliances 
It is specified whether each appliance is defined separately in the vertical diagram or if it 
will be integrated in a receptor group. In case that the check box is checked, the network 
is analyzed thoroughly in nodes. 

2. Building parameters 

 
If you select the Building in the upper left part of the screen, the building data will appear. 

The topology of the building as well as the layout of the installation network in it is 
included in the building parameters.  

Here the levels (floors), which constitute the building, are defined. In “Building options” the 
levels of the buildings are checked. In particular, if you select the Basement and the 
Floors, an additional field will appear where you fill in their number. You can also define 
the number of the apartments in each floor as well as the height of each floor. 

After you have defined the building data, press the key “Apply” and the building will 
appear in the left column in a tree form with an icon in front of it that shows the floor type. 

Working with levels 
If you click with the left mouse key on the level name, the options “Level Name”, “Level 
Height (m)” and “Number of Apartments” appear on the right side. You can enter the fields 
“Level Name” and “Level Height (m)” and edit the level data. 

If you double click with the left mouse key on the level name, the floor topology with the 
apartments will appear in tree form. 

If you click with the right mouse key on the floor name, a menu with the following options 
will appear: 

• New apartment entry: You can insert a new apartment besides the ones that are 
defined so far.  
• Copy of floor: Copies in the PC memory (clipboard) 
the floor network in order to paste (copy) it later on a 
different floor.  
• Paste: Pastes the network data that are saved in the clipboard to the selected floor. 
The data that are already entered in the floor shall be overwritten by the new data. 
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Working with apartments 
If you double click on the floor the apartments will appear and in the right side will appear 
the option “Insert Space with water supply”, where a list with various system types will be 
shown. If you double click on each system, its drawing will appear underneath it. If you 
double click on the desired system, this will be transferred automatically in the apartment 
selected in the left column. In the same way you can add more systems in the same 
apartment or in different. 

 
If you right click with your mouse on an apartment, the list shown in the next window will 
appear, with which you can manage the systems: 

• The command “Insert new system“. 

• The commands “Delete of” deletes the selected system. 

• The command “Copy of” copies the selected system. 

3. Network data 
In the option connections you can see the network structure from the Fire Fighting until 
each apartment. 

 
In this option, you can manage the Fire Fighting systems. At first, there is a separate Fire 
Fighting system for every apartment. If for example, there are two apartments in the 
building with common ownership, which are located in different floors, then you can 
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transfer the Fire Fighting from a column to a different one, to delete a column or a certain 
flow gauge. This is achieved by right clicking on an element. Depending on the ''tree'' 
element on the left side of the window that you right click, a menu appears which enables 
you to move or delete or even add an element. Hence, you are able to modify the network 
as it is desired. 

4. Diagram 
With this option, the vertical diagram of the previously mentioned installation appears. 
Moreover, you can change the colors that appear in the diagram.  

 
3.5.2 Update from vertical diagram 
This command is used to transfer the network data of the vertical diagram in the 
“Calculation sheet”.  

3.6 View 
This option includes the secondary option "Toolbars" and follows in general the windows 
standards. 

3.7 Windows 
The option “Windows” includes a series of calculation and result windows, in which the 
detailed project calculations are presented. The main window which comprises the core of 
the application calculations is the Calculation Sheet, and is described in the following 
paragraphs. 

3.7.1 Cover Page 
The “Cover page” window is the first printed page of the project and if the user wants, he 
can easily change it or create his own. 

To load or create a different cover page, in the program menu go to Cover page > 
Prototypes, select the prototype you want and press “Load”. If you want to save the cover 
page you made and use it in other projects, in the same window enter a name and a 
number (e.g. 02 Simple Alignment) and choose “Save as”. 
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If you want to edit the cover page, press the “Edit text” button , make the changes you 
want and then press it again in order to save them. The same applies if you want to edit 
the prototype cover page and in this case you press the “Edit prototype” button . 

Note: The cover page file is stored in FINE14_FIRE\CALC\PYRO\, named 
PYROCV01.RTF 

3.7.2 Assumptions 
The text of the project general assumptions, which may be included in the printed project 
as long as it is selected in "Printing Contents", is stated. If the option “Assumptions” is 
selected, you can load a different prototype or create your own from the program menu 
Assumptions > Prototypes. To do this, go to Assumptions > Prototypes, select the 
prototype you want and press “Load”. If you want to save the assumptions you made and 
use it in other projects, in the same window enter a name and a number (e.g. 02 Simple 
Alignment) and choose “Save as”. 

If you want to edit the assumptions, press the “Edit text” button , make the changes 
you want and then press it again in order to save them. The same applies if you want to 
edit the prototype assumptions page and in this case you press the “Edit prototype” button 

. 

Note: The assumptions file is stored in FINE14_FIRE\CALC\PYRO\ , named 
PYROPR01.RTF 

3.7.3 Systems of Receptors 
Here the Receptor Systems that are used in the specific project are presented and 
analyzed in the receptors constituting them. 

3.7.4 Receptors Legend 
The receptors used in the project are presented. 

3.7.5 Calculation Sheet 
The Calculation Sheet of the Fire Fighting System is the core of the calculations and 
conforms to the general rules of the Network Calculation Sheets, which are described in 
the first section. Therefore, each row of this sheet corresponds to a different network 
section while each column refers to the data that will be filled-in or will ensue automatically 
during the procedure of data completing. Help instructions concerning data entering 
appear at the bottom of the screen (status bar). In each row, the fields of the first column, 
which refer to section designations, should be filled-in first of all.  

The method for the network standardization is based exactly on the standardization rules 
that were explained earlier. Here is a short description of the columns of the calculation 
sheet:  
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1. Network section: In the rows of the first column you fill-in all the network sections (one 
section in each row) one by one. The sections are defined by their end nodes. You may 
assign a number (from 1 to 9999) or a letter (lower or upper case, e.g. Α2, AB, 3c, Aa etc.) 
to each node. The basic restriction in numbering is that number 1 is always assigned to 
the point that is connected to the gauge. Except the number "1", the same number should 
not appear in the network twice. After the numbering, you can enter in the calculation 
sheet all the sections independently one by one (the sequence of the sections is not 
important), by filling-in the first column: 

In the case of typical (similar) sections it is possible to recall them (with their name from 
the first column) in order to automatically transfer them. 

2. Pipe length: You must enter the pipe length in (m) in every section between two nodes 
(e.g. section 2.3). 

3. Type of receptor: If there is a receptor (appliance) at the specific network section, that 
is to say if the section ends up to a receptor, you can 
select it from the library with the Fire Fighting network 
appliances, after pressing the key F11 or by pressing the 
key inside the field in this column. A window will appear 
with the list of the appliances. In this window, the type of 
the appliance (hydraulic receptor) is defined when a unit 
is filled-in in the last column, in the row that corresponds 
to the receptor, and the key “enter” is pressed after that 
in order to validate the data entered. By pressing "ΟΚ" 
you can return to the calculation sheet where you can 
notice that the order number of the receptor is filled-in. Alternatively, except defining only 
one receptor, you can also define a receptor group (receptor system) with up to 10 
different types of receptors in each section. Since you are working with receptor groups, 
the program enables the user to define an order number of the hydraulic receptors system 
i in the upper part, and the relevant receptor system appears in the sixth column of the 
Calculation Sheet with the form S-i, where i represents the order number of the defined 
System.  

With this feature you avoid filling-in again the same appliances, since you can fill-in 
directly the order number of the System. The method with receptor systems is indicated in 
the case of very large installations, where the cases are grouped in a few systems and the 
data volume is radically decreased in the calculation sheet. 
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4. Αrea of coverage per sprinkler (m²): This column is visible only when one of the 
methods Fully calculated systems NFPA 13, Fully calculated systems EN 12845, Fully 
calculated systems AS 2118, Fully calculated systems BS 9251, Fully calculated systems 
FM Global, or Fully calculated systems CEA 4001 has been selected. This field shows the 
area that covers the selected receptor. When you select a receptor and this field is blank, 
it will be automatically filled in with the maximum area of the receptor from the library. 
5. Design density (mm/min):  This column is visible only when one of the methods Fully 
calculated systems NFPA 13, Fully calculated systems EN 12845, Fully calculated 
systems AS 2118, Fully calculated systems BS 9251, Fully calculated systems FM Global, 
or Fully calculated systems CEA 4001 has been selected. This field shows the design 
density of the selected receptor. When you select a receptor and this field is blank, it will 
be automatically filled in with the design density of the receptor from the library.  

6. Receptor flow (l/min): The receptor capacity QR, or in general the network section 
capacity (theoretical sum of the capacities if all the receptors work at the same time) is 
automatically calculated. The program calculates automatically the capacity for the 
intermediate sections based on the capacity of the receptors that are supplied from this 
section.  

7. Peak capacity (l/min): The peak capacity Qs is 
calculated based on the total capacity of the 
previous column. The peak capacity is calculated 
from the relevant peak curve that depends on the 
"Type of building" which is defined in the "Network" 
window. 

8. Desired pipe size (mm): From this column you 
can select a different diameter from the one that is 
calculated by the program (and is shown in the 
next column). If you press F11 or the key in the 
field, the list with the diameters of the selected in the "Network" window pipe type is 
shown. 

With the option "Select" you can select the desirable diameter, and you can see the 
effects of your choice in the rest of the network parameters (e.g. velocity, friction values 
etc). If you press <Del> in the relevant component of the calculation sheet you can delete 
the selected diameter, and the program will calculate again the diameter. 

9. Pipe size (mm): In this column, the pipe diameter of the network section is shown, as 
the program calculates it. 

10. Maximum velocity (m/s): In this column the velocity limit that is defined in the 
"Network" window is shown and you can modify it if you want for the particular network 
section. Keep in mind that, if you change later the general limit in the "Network" this will 
not affect the modified values, but only the initial ones (the ones that have the same value 
with the “Maximum network velocity” which is defined 
in the “Network”). 

11. Water velocity (m/s): The water velocity as it is 
calculated in the specific network section is shown 
here.  

12. Type of fittings: This column refers to the type 
of fittings (elbows, tee sections, valves etc.) that 
appear in the network section. If you want to fill in the 
components in detail, press F11 or the key in the 
field in this column, and the window with the list of 
the Fire Fighting system components from the 
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relevant library will appear. If only one component exists, this is defined by writing the 
number 1 in the last column, in the row that corresponds to the component. By pressing 
"ΟΚ" you can return to the calculations sheet where you can notice that the order number 
of the defined component is filled in.  

For more than one component you can fill in correspondingly the last column of the table 
with components, giving also the quantities of each component (up to 10 different types of 
components per section). In the case that you have more than one component, the 
indication F- appears which means in general "Fittings". If, in the upper part of the 
component table, you define a component system number a, in this column the indication 
F-a will appear. In this way you can group the components and also avoid filling in the 
same groups (systems), since in the “Type of fittings” column where the components are 
defined you can fill in directly the system number. 

Note: In the methods Fully calculated systems NFPA 13, Fully calculated systems EN 
12845, Fully calculated systems AS 2118, Fully calculated systems BS 9251, Fully 
calculated systems FM Global and Fully calculated systems CEA 4001 the program 
calculates automatically the “Equivalent length” of the fittings in each pipe section. To see 
it, you can go to Files > Printing contents and check the “Piping calculations”. 

13. Fittings friction drop (bar): The calculated friction value of the fittings in the specific 
network section is shown here.  

14. Pipes friction drop (bar): The calculated friction value for the piping in the specific 
network section is shown here. This friction is calculated from the water flow in the said 
section, based on hydraulic calculations. 

15. Total friction loss (bar): The sum of the Friction of Components and the Friction of 
Piping is shown in this column. 

Note: The velocity and the friction in each section have been calculated using the design 
flow of the sprinkler.  

Following you will see the columns "Circuit Polar angle", “Receptors group”, "Required 
discharge pressure", "Pressure Difference (DP) due to different height", “Pipe design 
length" and “Type of pipe". These columns can be filled-in directly in the relevant columns 
or from an additional window, which appears if you press the key F12 in any column or if 
you press the right mouse button and select from the list, ''Options". The use of these 
items is explained below:  

16. Circuit Polar Angle: It is necessary to fill in the polar angle of each network section 
only in case that you want to draw the vertical diagram directly from the calculation sheet 
and not generate it automatically from FINE FIRE. The vertical diagram that is drawn 
takes into account the length and the polar angle (in relation to the horizontal axis) of each 
section.  

17. Receptors Group: If you want to set several receptors into the same group, in this 
column the number of the group will be shown. Usually, a group consists of a number of 
sprinklers, or a fire hose cabinet plus some sprinklers.  

In case a sprinkler belongs to more than one group, type the number of the groups as e.g. 
“1,3”. The calculations for each group are made using the initial design flow of the 
sprinklers.  

Note: The “piping calculations” are printed for each sprinkler group separately. 

18. Required discharge pressure (bar): Here you have to fill in the required pressure of 
the receptor, which must be at least equal to its minimum discharge pressure. The above 
mentioned pressure is filled in only in case that you have given a direct flow or a receptor 
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system, since in the case that you select a receptor from the library the discharge 
pressure is filled in automatically. 

19. Pressure Difference (DP) due to different height (bar): In this column you fill in the 
Pressure Difference (DP) due to the receptor level elevation (positive or negative values). 
This is the elevation from the supply point to the receptor. This is provided only in the 
sections with receptors and not in intermediate sections. 
20. Pipe design length (m): Sometimes, when drawing a vertical diagram, you may 
design very short or very long sections. For that reason, in this column you can define an 
arbitrary pipe length, which however will affect only the way that the pipes are depicted in 
the drawing. Regardless of the length that you define in this field, the program shall write 
the real pipe length on the drawing. It should be pointed out that in case you do not fill in 
this field, the program shall draw the vertical diagram based on the column “Pipe length” 
of the ''Calculation Sheet''. 

21. Type of pipe: Select the type of the pipe between primary and secondary (you define 
the pipe materials in Project Data > Network window). 

Fixed column: Moreover, through the "Calculation Sheet" menu in the upper part of the 
window, you can select the number of "Fixed Columns" so that these columns of the 
calculation sheet "freeze" on the screen. In this way, as you fill in the fields of the sheet 
and you are "led" towards the right, you will know exactly on which network section you 
are working on anytime. When the "Fixed Column" option is active, a yellow point (pin) 
appears at the bottom of the "frozen" field. 

3.7.6 Fire Pump Calculation 
In the ‘’Fire pump calculation’’ window you can select the fire pump, calculate the motor 
power and run an NPSH (Net Positive Suction Head) check.  

 
Fire Pump Calculation 
In this tab you can calculate and select the type of the fire pump and calculate 
automatically the motor power. The results that appear in red color have been 
automatically calculated and you only have to fill in the “Efficiency of main pump”, 
“Efficiency of electric motor main pump” and “Efficiency of diesel main pump”. When these 
fields have been completed, the minimum volume of the pressure tank is calculated and 
you can select in the “Type of selected fire pump” field the appropriate fire pump from the 
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library. When you select the fire pump, you can see on the right side of the window its 
pump curve. 

When one of the methods Fully calculated systems NFPA 13, Fully calculated systems 
EN 12845, Fully calculated systems AS 2118, Fully calculated systems BS 9251, Fully 
calculated systems FM Global or Fully calculated systems CEA 4001 has been selected, 
the most unfavourable and most favourable areas are depicted on the curve, along with 
the design pump flow and the maximum pump flow.   

Note: 

- For the calculation of the fire pump all the sprinkler groups have been taken into account 
with their calculated flows. 

NPSH Check 
This option is not available for the “NFPA Ordinary Hazard pipe schedule” and the 
“Hydraulic Calculations” methods. 

• Type of suction head: Select the type of the suction head between ‘’Positive 
head” conditions and “Suction lift” conditions. 

• Pipe type: With the key <F11> or by pressing the key in this field, you can select 
from the window that appears, the pipe type that shall be connected to the pump 
suction. 

• Pipe length: Enter the length of the pipe that shall be connected to the pump 
suction (in m). 

• Equivalent length of fittings: Select the type of fittings that are used. To fill in the 
components, press F11 or the key in the field and the window with the list of the 
fittings will appear. To select a fitting, write the number “1” in the last column in the 
row that corresponds to the component. By pressing “OK” the program calculates 
automatically the “equivalent length” (in m). 

• Desired pipe size: If you want a different pipe size from the calculated, you can 
select it from the list that appears when pressing the key in this field. 

• Static pressure in the fluid: Enter the static pressure in the fluid Pstat (in 
mmH2O). 

• Fluid vapour pressure: Select a fluid vapour pressure from the table that opens 
when pressing the key in this field. 

When the fields have been filled in, you can see on the right side of the window the NPSH 
curve (right below the pump curve) and the program checks whether the pump can work 
at its maximum operating point at all levels of the water supply NPSHa - NPSHr ≥ 1m. 

3.7.7 Water Tank Calculation 
In this window you can calculate the size of the water tank, which is necessary for the 
installation.  

3.7.8 Network Drawing 
The numbered network drawing is shown on the screen, provided that polar coordinates 
have been inserted in every network branch (see calculation sheet). 

3.7.9 Vertical diagram 
If you want to create a vertical diagram using the calculation sheet (and not automatically, 
using FINE FIRE program), the above option creates the vertical diagram provided that 
the polar coordinates have been inserted in every network section.  
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It is pointed out that it is possible to load a drawing for the engine room from the menu 
Vertical diagram > Select side for machine room.  

3.7.10 Sections Friction drop 
In this window you can view the total frictions in all sections starting from the gauge and 
ending in each terminal node. Moreover, for more convenience, the most unfavourable 
network section appears in the bottom of the window. 

When one of the methods Fully calculated systems NFPA 13, Fully calculated systems 
EN 12845, Fully calculated systems AS 2118, Fully calculated systems BS 9251, Fully 
calculated systems FM Global or Fully calculated systems CEA 4001 has been selected, 
you can view the total frictions for the stabilized flow condition for each sprinkler group 
separately. You can also see in the window the most favourable and unfavourable groups 
with their required pressures, their capacities and the sections with the highest pressure 
drop. 

3.7.11 Network checking 
In this window, the program checks for any pipe sections in the stabilized flow condition 
that their velocity exceeds the maximum or they have no flow. The results are presented 
under each sprinkler group.  

Note: This option is not available for the “NFPA Ordinary Hazard pipe schedule” and the 
“Hydraulic Calculations” methods. 

3.7.12 Four sprinklers under consideration 
This window is shown only when the calculation method includes the calculation of the 4 
worst sprinklers of the network. 

When you have been transferred to the calculations from the drawing, the program finds 
automatically the 4 worst and best sprinklers under consideration; it shows the specified 
density of each group (best and worst) and calculates the density over the 4 sprinklers. 
With the exception of the first row in each table which shows the worst sprinkler of the 
group, you can edit the rest by pressing the selection button in the row or even delete a 
sprinkler from the group. If you edit the rows and want to return to the information 
transferred from the drawing, select the ‘’Update from drawing’’ button.  

Note: This option is not available for the “NFPA Ordinary Hazard Pipe Schedule”, the 
“Hydraulic Calculations”, the “Fully calculated systems NFPA 13” and the “Fully calculated 
systems FM Global” methods. 

3.7.13 Bill of Materials - Costing 
The bill of materials-costing results regarding the specific project is presented. You can 
edit the bill of materials-cost estimation sheet, modify the costs or quantities, insert 
discounts and add jobs or materials followed by their costs and quantities. 

3.7.14 Detailed Bill of Materials  
The exact quantity of the materials that have been used in the specific installation (i.e. 
pipes, number of sprinklers etc.) is being generated by the program in an editable table 
form. 

3.7.15 Technical Description 
The window “Technical Description” supports the creation of the project technical 
description. You can select among various technical description prototypes and text 
editing styles. To load a different technical description, in the program menu go to 
Technical description > Prototypes, select the prototype you want and press “Load”. If you 
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want to save the technical description you made so as to use it again, in the same window 
enter a name and a number (e.g. 02 Sprinkler technical description) and choose “Save 
as”. 

If you want to edit the technical description, press the “Edit text” button , make the 
changes you want and then press it again in order to save them. The same applies if you 
want to edit the prototype technical descriptions page and in this case you press the “Edit 
prototype” button . 

Note: The technical description file is stored in FINE14_FIRE\CALC\PYRO\ , named 
PYROTP01.RTF 

3.8 Libraries 
The Fire Fighting Libraries comprise the following material categories, with their 
respective features: 

• Fittings, with specified characteristics (coefficient z, cost) 

• Pipes (pipe types) with a given roughness, standardization (nominal, internal 
diameter) and material. 

• Receptors (connection pipe size, water flow, cost etc.). 

• Fire pumps, with all their features and their performance. 

• System of receptors: The library is fitted with a tool that allows the design of new 
receptor systems as well as the modification of the existing ones.  

• Offer libraries: You can add your own offer libraries. 

In any of the above libraries, you can easily change or add your own information. In order 

to add a new fitting, receptor etc. press the “Append record” button  at the bottom of 
the page. The program automatically creates a new blank row where you add the 

information you want and after pressing the “Post edit” button  you press OK. In this 
way, you can use your own libraries in every project you are working. 

3.9 Help 
In this option you will find the instructions of the program, according to the windows 
standards. 

3.10 Examples 
In this chapter two step-by-step examples are presented, which will help you understand 
in practice the basics of drawing in FINE FIRe. These simple examples aim mainly at 
helping you start drawing building entities (walls, openings etc.) along with the fire fighting 
network. More specifically: 

- Example 1, describes the steps of drawing a simple level (optional). 

- Example 2, describes the steps of drawing a simple fire fighting network, 
proceeding to the calculations and generating the necessary drawings.  
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Important: It isn’t necessary to draw the levels of the building with walls, openings 
etc. in order to calculate the fire fighting network. If you already have 2D architectural 
drawings of the levels you can insert them and place on them the receptors, the pipes etc. 
Nevertheless, if you do not have architectural drawings, it will be more helpful to draw the 
walls etc. so as to be able to design the network more accurately.  

Apart from the following examples, you can watch the same steps (and much more) in the 
videos you will find in http://www.4msa.com/FineFireENG.html. 
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3.10.1. Building design example 
In this example, the drawing of the 
adjacent simple building is described, 
including the steps from the beginning 
(creating a new project) to the end so that 
you can easily understand the function of 
FINE FIRE in practice. 

For this example, we will import two 
architectural plan views that have been 
designed in AutoCAD although you can 
start drawing from scratch. If you have 
already designed the building in IDEA 
Architecture 14, you can skip this 
example. 

1. From FILES menu, we select “New project”, type “Example_1” and press “Accept”. 

2. From AutoBLD menu, we select “Building definition”, define as level 1 the “Basement” 
in elevation “-3” and from “File” we load its architectural drawing. Before we define the 
second level, we press “New” (so as to save the changes) and we follow the same 
steps for the second level, as it is shown below. 

 
 

When we finish, we press once again “New” and then “Accept” and automatically we 
defined the two levels with their architectural drawings. 

3.  Before we start drawing, we “Lock” the architectural drawings from the layers list on 
the left by pressing the “Lock” symbol as it is shown below. The name of the 
architectural drawing will be BASE_FLOO1_XREF for the first level, 
BASE_FLOO2_XREF for the second level etc. 

- 48 -  FineFIRE 



 
 

 
4. From AutoBLD, we select Walls > Outer wall 

and in the properties window we define the 
height (3 m in our example) and the width 
(0.25 m) of the wall, the height and the width 
of the column (it will be automatically designed 
along with the wall), its type etc. 

When we finish, we press “Accept” and we 
design the wall by defining three points: 

- First, we click on the beginning of the wall  
(where the left red spot is, in the following 
image) 

- Then, we click on the end of the wall 
(where the upper right red spot is) and 

- Finally, we click on the side that the wall 
“grows” (where the down right red spot is). 

 
You can enable the “Entity snaps” toolbar (or the “ESNAP” setting) so as to select 
easily the edges of the wall. 
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Continuing in the same way, we draw all the walls (inner and outer) of the ground 
floor. 

 
5. From AutoBLD, we select Opening > Door and in the 

properties window, we select the height (2.20 m in our 
example), the length (1 m), the type of the door etc.  

When we finish, we press “Accept” and we design the door: 

- First, we select the wall upon which we want to place the 
door. 

- We click on the starting point of the door  (where the left 
red spot is, in the following image) 

- We click on the ending point of the door (where the upper 
right red spot is). As long as you have specified the length 
of the door, it is not necessary to specify this point 
exactly. You only need to specify a point near the start towards the side that the 
second point is located.  

- Finally, we click on a point that shows the direction towards which the door will 
open (where the down right red spot is). 
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6. From AutoBLD, we select Opening > Window and in the 
properties window, we select the height (1.20 m in our 
example), the length (1 m), the rise (0.80 m), the type of 
the window etc.  

When we finish, we press “Accept” and we design the 
window: 

- First, we select the wall upon which we want to place 
the door. 

- We click on the starting point of the window  (where  
the upper red spot is, in the following image) 

- We click on the ending point of the window (where the 
down red spot is). As with the door, as long as you 
have specified the length of the window, it is not necessary to specify this point 
exactly. You only need to specify a point near the start towards the side that the 
second point is located.  

 
In the following image, we have deactivated the architectural drawing, so as to have a 
better inspection of the drawing. To do this, go to AutoBLD > Layers management > 
and uncheck the “XREF” box.  

 

FineFIRE  - 51- 



 
 

3.10.2. Fire fighting Network design example 
1. From Plus menu > we select “Set elevation” and in the command line we type “2.8” 

meters. In this way, everything that we are going to design will be placed in 2.8 m in z 
axis in relation to each level.  

2. We draw the fire fighting spaces where the sprinklers will be placed from AutoNET > 
Create fire fighting space. In the window that opens, we give the name “Space 1” for 
the first room and we define the “Hazard” and the “Minimum density” (5 mm/min in this 
example).  

 
We select to define the space by giving “points”, so we click on the edges of the room 
as it is shown in the following picture. 

 
 When we finish, we press <ENTER> and in the window that opens again we select 
“Accept”. The first space has been drawn. Alternatively, we can define the space by 
selecting a polyline. 
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We continue in the same way and draw the rest of the fire fighting spaces and we get 
the following picture. 

 
3. The next step is to place the sprinklers on the drawing. In this example we will place 

them directly in grids using the “Sprinklers Grid” command from the AutoNET menu. In 
the window that opens: 

• We press on the “Receptor” button and select the “Sprinkler OH roof” type 
(automatically the “Area of coverage” is filled in). 

• We choose to define the area of the grid by selecting directly the “Fire fighting 
space” so we press the button and we select the “Space 1” from the drawing. 

• Automatically, the “Rect dimensions” and the “Area” are updated and the 
program calculates the minimum number of the sprinklers as “3” and proposes 
to draw 2 rows and 2 columns (in the “Proposed Lines-Columns” area as it is 
shown in the picture). 
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• The next step is to select the number of the rows and the columns of the grid. 
For this example, we will follow the suggestion of the program and type “2” in 
both the “Number” cells and we see that automatically the vertical and the 
intermediate distances of the sprinklers are calculated (we can edit these 
distances directly if we want).  

• Finishing, we press “Accept” and the grid is designed. 

 
• We repeat the same step until we have designed the grids for all the spaces. 
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4. Next, from AutoNET > we select the “Create area of coverage per sprinkler” 
command, to check if the sprinklers that we selected can cover the spaces. We simply 
click on the names of the fire fighting spaces (Space 1, Space 2 etc.) and the program 
draws the coverage outlines. In our example the outlines are in green color, meaning 
that our sprinklers can cover the spaces.  

 
5. From AutoNET > we select “Pipe” and start drawing the fire fighting network. If you 

want, you can draw the pipes in a different elevation by repeating step 1 (in our 
example, we draw the sprinklers in an elevation of “2.8” m) or draw curved pipes (from 
AutoNET > ‘’Curved pipe’’). 
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6. The next step is to connect the pipes with the sprinklers and we do this easily by 

selecting from AutoNET > ‘’Connect receptors to existing pipe’’ (or from the 

corresponding symbol   of the toolbar).  

- We click on the first receptor 

- We click on the pipe next to it 

- We press ENTER and they are automatically connected. 

- We repeat the step for all the receptors (we can connect more than one receptor to 
the same pipe each time). 

 
7. If we want to place a vertical pipe that leads to the basement, we select from AutoNET 

> ‘’Main vertical pipes’’: 

- We click on the location we want to place the vertical pipe (in the command line 
you can see the “Enter XY location” prompt message). 

- We type the height “-3” which is the starting point of the vertical pipe in this 
example (the basement elevation). 
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- We type the height “2.8” which is the ending point of the vertical pipe in this 
example (from the “Set elevation” command we have set the elevation we are 
drawing the pipes in the ground floor in “2.8” m) and the vertical pipe is created. 

 
8.  From AutoNET > we select ‘’Pipe’’ and draw a pipe connecting the horizontal to the 

vertical pipe as it is shown below. 

You can use the “Entity snaps” toolbar (it is shown in the picture) to connect precisely 
the two pipes. 

 
9. We delete the parts of the pipes that we do not want and we get the final network of 

the ground floor. 
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10. By selecting the level of the basement (you can use    to change levels or double 
click on the level’s name in the left side of the screen) we draw a horizontal pipe 
starting from the vertical pipe as it is shown below (you can easily connect the 
horizontal to the vertical duct using the “Perpendicular snap” point). 

Finally, from AutoNET > ‘’Supply point’’, we set the supply start point symbol (which is 
for the gauge position). You can easily connect the symbol to the horizontal pipe using 
the “Endpoint snap” point (highlighted in the following picture). 

 
9.   We can organize the receptors into groups so as to operate together in case of a fire 

incident. To do this, we select from AutoNET > ‘’Set group to receptors’’, choose the 
sprinklers we want to work simultaneously and press ‘’Enter’’. In the command line 
the message “Enter group to assign the sprinklers” appears and we type “1”. We 
continue in the same way to assign the receptors into groups (2, 3 etc.).   
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10. Before we proceed to the calculations, we select from AutoNET > ‘’Network 

recognition’’. This is an important step in order to make sure that the network has 
been drawn correctly. If there are any mistakes, a warning message will appear, 
otherwise, the network sections are numbered as it is shown below and we can 
proceed to the calculations. 

 
11. From AutoNET > we select ‘’Calculations’’ and in the window that opens 

automatically, we select Files > Update from Drawing.  From Windows menu we open 
the Calculation Sheet where the network information has been transferred (detailed 
information in Chapter 3.7.5). 

FineFIRE  - 59- 



 
 

 
12. In the calculations part we can also select the fire pump and run an NPSH check from 

the “Fire pump calculation” window. We fill in the fields in black color in the “Fire 
pump” and “NPSH” tabs and select a fire pump. Automatically the curve of the pump 
is shown along with the most favourable and most unfavourable sections (detailed 
information in Chapter 3.7.6). 

 
We finish the calculations, we save and close the window and return to FINE FIRE. 

13. From AutoNET we select ‘’Update Drawing’’ and in the opening window we choose 
which information we want to be show on the screen for the pipes and the receptors. 
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By clicking “Auto Placement”, the selected information is shown on each level. 

 
14. From AutoNET we select ‘’Draw most favourable, most unfavourable group and 

area’’ and the program show on them on drawing (in green color the most 
favourable area and group and in red color the most unfavourable) as it is shown 
in the picture. 
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15.  Finally from AutoNET we select ‘’Convert single line to 3D’’ and the program 

automatically converts the network into 3D in relation to the calculation results. 
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